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Learning Objectives

By the end of this presentation, you will be able to: 
• Understand the basic physics of SAR interferometry
• Describe what SAR interferometric phase tells about the land surface
• Describe the necessary data processing for making an interferogram
• Understand the information content in SAR interferometric images
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Prerequisites

• Basics of Synthetic Aperture Radar 2017
• SAR Processing and Data Analysis 2017
• Introduction to SAR Interferometry 2017

3
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SAR Interferometry Theory (Review)
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SAR Interferometry Theory

• Quick review of synthetic aperture radar interferometry theory
• See the 2017 ARSET training “Introduction to SAR Interferometry” for more details
• In SAR interferometry, it is all about the phase of the SAR signal
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SAR Phase – A Measure of the Range and Surface Complexity

Slide Courtesy of Paul Rosen (JPL)

0
1

2
…

The phase of the radar signal is the number of cycles of 
oscillation that the wave executes between the radar 
and the surface and back again

The total phase is a two-way range measured in wave 
cycles + random components from the surface

Number of Cycles 
(actually millions!)

Collection of random path lengths jumbles the phase 
of the echo

Only interferometry can sort it out!
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A Simplistic View of SAR Phases

Phase of Image 1

Phase of Image 2

1. The “other constants” cannot be directly determined

2. “Other constants” depends on scatterer distribution in the resolution cell, which is 
unknown and varies from cell to cell

3. The only way of observing the range change is through interferometry 
(cancellation of “other constants”)

Slide modified from Paul Rosen (JPL)
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SAR Interferometry Applications

• Mapping/Cartography
– SAR interferometry was used for the 2000 Shuttle Radar Topography Mission (SRTM), new 

2018 release as NASADEM
– Radar Interferometry from airborne platforms is routinely used to produce topographic 

maps as digital elevation models (DEMs)
• 2–5 meter circular position accuracy
• 5–10 m post spacing and resolution
• 10 km by 80 km DEMs produced in 1 hr on a mini-supercomputer
• NASA SAR topography presently acquired by GLISTIN

– Radar imagery is automatically geocoded, becoming easily combined with other 
(multispectral) data sets

– Applications of topography enabled by interferometric rapid mapping
• Land use management, classification, hazard assessment, intelligence, urban 

planning, short and long time scale geology, hydrology
Slide Modified from Paul Rosen (JPL)
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SAR Interferometry Applications

• Deformation Mapping and Change Detection
– Repeat Pass Radar Interferometry from spaceborne platforms is routinely used to 

produce topographic change maps as digital displacement models (DDMs).
• 0.1–1 centimeter relative displacement accuracy
• 10–100 m post spacing and resolution
• 10–350 km wide DDMs produced rapidly once data is available

– Applications include
• Earthquake and volcano monitoring and modeling, landslides and subsidence
• Glacier and ice sheet dynamics
• Deforestation, change detection, disaster monitoring
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Differential Interferometry

• When two observations are made from the same location in space but at different 
times, the interferometric phase is proportional to any change in the range of a 
surface feature directly.

Slide modified from Paul Rosen (JPL)
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Differential Interferometry Sensitivities
• The reason differential interferometry can detect millimeter-level surface deformation is 

that the differential phase is much more sensitive to displacements than to topography.

Slide modified from Paul Rosen (JPL)

Topographic Sensitivity

Topographic Sensitivity Term

Displacement Sensitivity Term

Since ==>

Meter Scale Topography Measurement - Millimeter Scale Topographic Change

Displacement Sensitivity(φ  ∆φ)
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Phase Unwrapping

• From the measured, wrapped phase, unwrap the phase from some arbitrary 
starting location, then determine the proper 2p phase “ambiguity”

Slide modified from Paul Rosen (JPL)

Actual phase

Wrapped (measured) phase

Typical unwrapped 
phase
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Correlation* Theory

• InSAR signals decorrelate (become incoherent) due to
– Thermal and Processor Noise
– Differential Geometric and Volumetric Scattering
– Rotation of Viewing Geometry
– Random Motions Over Time

• Decorrelation relates to the local phase standard deviation of the interferogram 
phase
– Affects height and displacement accuracy
– Affects ability to unwrap phase

*“Correlation” and “Coherence” are often used synonymously

Slide modified from Paul Rosen (JPL)
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InSAR Correlation Components

• Correlation effects multiply, unlike phase effects that add
• Low coherence or decorrelation for any reason causes loss of information in that 

area

γ= γv γg γt γc
where
γv is volumetric (trees)
γg is geometric (steep slopes)
γt is temporal (gradual changes)
γc is sudden changes
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Wavelength: A Measure of Surface Scale

Slide modified from Paul Rosen (JPL)

Light interacts most strongly with objects 
around the size of the wavelength

Forest: Leaves reflect X-band 
wavelengths but not L-band

Ice: Surface and layering look 
rough to X-band but not L-
band

Dry Soils: Surface looks rough 
to X-band but not L-band

L (24 cm) C (6 cm) X (3 cm)
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Coherent Change Detection

• 6-month time separated observations to form interferograms
• Simultaneous C and L band

SIR-C L and C-band Interferometry

InSAR experiments have shown good correlation at L-band



Image Credit: NASA/JPL

InSAR Applications—Earthquakes, etc.
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Some Examples of Deformation

Slide modified from Paul Rosen (JPL)

Hector Mine
Earthquake

Etna Volcano

Joughin et al , 1999

Ice Velocities
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Asal Rift Dike Injection

Envisat interferogram 6 May – 28 Oct 
2005; form Tim Wright, U. Leeds
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2015 M7.8 Gorkha Earthquake in Nepal

• ALOS-2 ScanSAR interferogram
• Descending line-of-sight (LOS) perpendicular 

to horizontal
• InSAR phase only sees vertical component
• High Himalayas dropped down as much as 

1.2 m
• Yue, H., et al. (2017), Depth varying rupture 

properties during the 2015 Mw 7.8 Gorkha 
(Nepal) earthquake, Tectonophysics, v. 714-
715, p. 44-54, doi:10.1016/j.tecto.2016.07.005.

GPS data from Galetzka, J., et al. (2015), Science, 349 (6252), 1091-1095

Slip pulse and resonance of the Kathmandu 
basin during the 2015 Gorkha earthquake, 
Nepal
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Creep on the San Andreas Fault

Figures from Isabelle Ryder, UC Berkeley

Stack of 12 ERS 
interferograms 

spanning May 1992-
Jan 2001
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Decorrelation Shows Surface Ruptures

Fielding, E. J., M. Talebian, P. A. Rosen, H. Nazari, J. A. Jackson, M. Ghorashi, and R. Walker (2005), Surface ruptures and building damage of the 2003 Bam, Iran, earthquake mapped by satellite synthetic aperture radar interferometric 
correlation, J. Geophys. Res., 110(B3), B03302, doi:10.1029/2004JB003299.

Bam

Baravat

RR

10 km

SM Envisat 35 days
2003/12/3 –
2004/1/7

Descending track

Bperp 580 m

2003 M6.5 Bam 
earthquake in Iran
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Correlation change

Envisat co-seismic
correlation minus pre-
seismic correlation

red is co-seismic
decorrelation

Bam

Baravat
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Landslide Motion
Combination of Four NASA UAVSAR InSAR Flight Lines

Delbridge, B. G., R. Bürgmann, E. Fielding, S. Hensley, and W. H. Schulz (2016), Three-dimensional surface deformation derived from airborne interferometric UAVSAR: Application to the Slumgullion Landslide, J. Geophys. Res. Solid Earth, 
121(5), 3951--3977, doi:10.1002/2015JB012559.

cm/day



repeat

cycle

(days)

wave-

length

(cm)

European ERS-1/ERS-2 ‘92-’01(-2011) 35 (1,3,183) 6

Canadian Radarsat-1 1995-2013 24 6
European Envisat  ‘03-Sep.’10(‘10-Apr.’12) 35 (30) 6

Japanese ALOS Jan. 2006–Apr. 2011 46 24

German TerraSAR-X ’07, TanDEM-X ‘10 11 3

Italian COSMO-SkyMed 4x launch ‘07-’10 16 (1,4,7,8) 3

Canadian Radarsat-2 launched Dec. 2007 24 6

SAR satellites



new SAR spacecraft

satellite (launch or planned)
repeat

cycle

(days)

wave-

length

(cm)

European Sentinel-1 (A: Apr. 2014, B: May 2015) 12(6) 6

Japanese ALOS-2 (May 2014) 14 24

Indian RISAT-1 (Apr. 2012) 25 6

N ASA-ISRO SAR (N ISAR) mission (2021) 12 12,24
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NASA-ISRO SAR Mission (NISAR)

• High spatial resolution with frequent 
revisit time

• Earliest baseline launch date: 2021
• Dual frequency L- and S-band SAR

– L-band SAR from NASA and S-band 
SAR from ISRO

• 3 years science operations (5+ years 
consumables)

• All science data will be made 
available free and open

• https://nisar.jpl.nasa.gov

Slide Courtesy of Paul Rosen (JPL)

https://nisar.jpl.nasa.gov/


Image Credit: NASA/JPL

Accessing, Opening, and Displaying SAR 
Interferometry Data
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How to Get Data for InSAR
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Southern Mexico Earthquakes 2017–2018

We will look 
at the 16 
February 
2018 Mw 7.2 
earthquake 
near 
Pinotepa in 
Oaxaca
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Accessing Sentinel-1 Data for Interferometry

1. Go to the Alaska Satellite Facility Sentinel Data Portal: 
https://vertex.daac.asf.alaska.edu/

2. Identify the area (-99,16,-99,15,-97,15,-97,16,-99,16) and dates (2018-02-05, 2018-
02-17) of interest (M7.2 Pinotepa earthquake in Oaxaca, Mexico)

3. Identify images of interest (Sentinel-1 A/B)
4. Select path 5
5. Click Search
6. Select Granule: 

S1B_IW_RAW__0SDV_20180205T003836_20180205T003909_009481_0110E0_FEAF 
(Frame 49)

7. Download the L1 Single Look Complex (SLC) (4.76 GB) Product
8. Similarly download SLC for Granule: 

S1B_IW_RAW__0SDV_20180217T003836_20180217T003908_009656_0116A5_3F00 
(Frame 49)

https://vertex.daac.asf.alaska.edu/
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Accessing Sentinel-1 Data for Interferometry
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Opening the Data with the Sentinel Toolbox

We use the same Toolbox as for SAR amplitude analysis
• Initiate the Sentinel Toolbox (SNAP) by clicking on its desktop icon
• In the Sentinel Toolbox interface, go to the File menu and select Open Product
• Select the folder containing your Sentinel-1 SLC file, and double click on the .zip file 

(do not unzip the file; the program will do it for you)
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Opening the Data with the Sentinel Toolbox

1. The Product Explorer window of the Sentinel Toolbox 
contains your file. Double click on the file to view the 
directories within the file, which contain information 
relevant to the image, including: 

– Metadata: parameters related to orbit and data
– Tie Point Grids: interpolation of latitude/longitude, 

incidence angle, etc.
– Quicklooks: viewable image of whole scene in 

radar coordinates
– Bands: complex values for each subswath “i” and 

“q” and intensity (intensity is the amplitude squared, 
a virtual band)

SLC Data Has a Different Format Than GRDH
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Opening the Data with the Sentinel Toolbox

2. The Worldview image (lower left) 
shows the footprint of the whole 
image selected

3. Select intensity image for swath IW1 
VV

– Note: Each SAR image is flipped 
north—south because it is oriented 
the same way it was acquired 
(ascending track in this case)

Viewing Subswath Images



Image Credit: NASA/JPL

InSAR Processing
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Interferometry Data Preparation
Coregistering the Scenes

1. The first step of interferometry is to coregister
two SLC images

2. From the top main menu bar, select Radar, 
then Coregistration, then S1 TOPS 
Coregistration, and then S1 TOPS 
Coregistration again

– In the Read tab, select the 20180205 SLC 
and in the Read(2) tab select the 20180217 
SLC

– In TOPSAR-Split and TOPSAR-Split(2) tabs, 
select Subswath: IW1 Polarisations: VV

– In the Write tab, select the directory where 
you want to save your processing results
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Interferometric Processing

1. Second step of interferometry is to make 
an interferogram out of the coregistered
SLC images

2. From the top main menu bar, select 
Radar, then Interferometric, then 
Products, and then Interferogram 
Formation

– In I/O Parameters tab, select the 
“Orb_Stack” product created by the 
coregistration step

– By default, the output target is in same 
directory and adds “ifg” to the name

– For basic processing, no need to 
change defaults in Processing 
Parameters tab

Forming a Raw Interferogram
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Interferometric Processing
Viewing a Raw Interferogram — Phase Image
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Interferometric Processing

1. Next step of interferometry with Sentinel-1 
TOPS mode (IWS) data is “debursting” or 
combining the bursts. This is not 
necessary with Sentinel-1 or other 
stripmap SAR data.

2. From the top main menu bar, select 
Radar, then Sentinel-1 TOPS, and then S-1 
TOPS deburst

– In I/O Parameters tab, select the 
“Orb_Stack_ifg” product created by 
the interferogram formation step

– By default, the output target adds 
“deb” to the name

– No need to change Processing 
Parameters tab

TOPS Debursting and Topographic Phase Removal
3. Next step for all interferometry is to remove 

the topographic phase using a DEM.
4. From the top main menu bar, select 

Radar, then Interferometric, then 
Products, and then Topographic Phase 
Removal

– In I/O Parameters tab, select the 
“Orb_Stack_ifg_deb” product created 
by the deburst step or “Stack_ifg” if not 
TOPS mode

– By default, the output target adds 
“dinsar” to the name

– The Processing Parameters tab shows 
the default is to download SRTM 3-
arcsecond DEM, which is fine for basic 
processing but you might need 
another DEM in some cases
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Interferometric Processing
Viewing Differential Interferogram — Phase Image
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Interferometric Processing

1. Two steps can reduce the noise level in 
the interferogram, filtering and multi-
looking. We apply filtering first, but you 
can also do multi-looking first.

2. From the top main menu bar, select 
Radar, then Interferometric, then Filtering, 
and then Goldstein Phase Filtering

– In I/O Parameters tab, select the 
“dinsar” product created by the 
previous step

– By default, the output target adds “flt” 
to the name

– For basic processing, no need to 
change defaults in Processing 
Parameters tab

Filtering and Multi-Looking Interferogram

3. Multi-looking is averaging multiple pixels 
in each direction, what radar engineers 
call ”taking multiple looks”. It results in 
larger pixels and can greatly reduce the 
noise. 

– The amount of multi-looking you should 
do depends on the spatial resolution 
you need and the spacing of the 
fringes
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Interferometric Processing

1. The Pinotepa earthquake has a depth of 
about 25 km, so the fringes are widely 
spaced. There is also no surface rupture, so 
we can do more spatial averaging without 
losing any earthquake signal.

2. From the top main menu bar, select Radar 
and then Multilooking

– In I/O Parameters tab, select the 
“dinsar_flt” product created by the filtering 
step and, by default, the output target 
adds “ML” to the name

– In Processing Parameters tab, select Source 
Bands “i_ifg”,“q_ifg”, and “coh”. For this 
scene, I use 17 range looks and it 
calculates 5 azimuth looks to give ~70 m 
output pixels

– Don’t choose “Phase” band!

Multi-Looking Interferogram



NASA’s Applied Remote Sensing Training Program 44

Interferometric Processing

1. First, we need to make a new virtual 
phase band after multi-looking the 
complex interferogram

2. From the top main menu bar, select 
Raster, then Data Conversion, then 
Complex i and q to Phase

3. Now you can display the new phase 
band

• The fringes are much less noisy
• Aspect ratio has changed so the pixels 

are roughly square on the ground
• New image is now 1207 pixels across, 

much smaller than original 20535 pixels

Viewing Multi-Looked Interferograms
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Interferometric Processing

1. SNAP 6.0 does not include phase 
unwrapping. It has way to export 
interferogram to unwrap with third-party 
program Snaphu (Statistical-cost, 
Network-flow Algorithm for Phase 
Unwrapping) by Chen and Zebker.

2. From the top main menu bar, select 
Radar, then Interferometric, then 
Unwrapping, and then Snaphu Export.

– In Read tab, select the “ML” product 
created by the multilooking step

– In Snaphu Export tab, change the 
Statistical-cost mode to “SMOOTH”

– Also change the number of tile rows 
and columns and number of processors 
to “1” because we don’t need multiple 
tiles after multilooking

Phase Unwrapping
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Interferometric Processing

1. In Snaphu Export tab, you also need to 
specify a target folder for exported files. I 
put the Snaphu files in a separate folder 
(here called “snaphu_unw”), so you need to 
create it either from the selection dialog or 
in another window.

2. The Snaphu Export pop-up dialog does not 
work quite right in SNAP 6.0. Workaround:

– Navigate to directory that includes the 
“snaphu_unw” folder

– The “select” button won’t work to chose 
the “snaphu_unw” folder

– Type “snaphu_unw” in the File: box at the 
top, then choose Select

3. Now you can press Run button and SNAP 
exports the interferogram phase and 
coherence with a “snaphu.conf” file

Phase Unwrapping
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Interferometric Processing

1. Installing Snaphu: ESA now provides pre-built 
binary executables for Linux and Windows 32- or 
64-bit systems at http://step.esa.int/main/third-
party-plugins-2/snaphu/. 
For Mac or other machines, you need to 
download from Stanford and build it yourself 
(“make” in “src” usually works). 

You also need to add the snaphu/bin directory 
to your path.

2. After the Snaphu Export step in Snap, you have to 
run the Snaphu program on the command line:

– Navigate to the “snaphu_unw” folder and 
open it

– You should see folder with name of product 
you exported, e.g. 
S1B_IW_SLC__1SDV_20180205T003836_2018
0205T003906_009481_0110E0_6407_Orb_St
ack_ifg_deb_dinsar_flt_ML17

– Move to that folder

Phase Unwrapping
3. You should see the wrapped 

interferogram phase “Phase_ifg*.img”, 
coherence “coh_*.img”, and a 
“snaphu.conf” file.

4. The beginning of the “snaphu.conf” file 
shows the command to run Snaphu, e.g.,

# Command to call snaphu:

#

#       snaphu -f snaphu.conf
Phase_ifg_VV_05Feb2018_17Feb2018.sna
phu.img 1207

5. The Snaphu program can take a long 
time to run. At the end it writes 
unwrapped phase to “Unw_ifg*.img” file

http://step.esa.int/main/third-party-plugins-2/snaphu/
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Interferometric Processing

1. Now, we import the unwrapped phase. 
From the top main menu bar, select 
Radar, then Interferometric, then 
Unwrapping, and then Snaphu Import.

2. The Read-Phase tab should be set to the 
wrapped product that you exported. 

3. In the Read-Unwrapped-Phase tab, select 
the unwrapped source product:

– Navigate to folder where you exported 
for Snaphu

– Select the 
“UnwPhase_ifg*.snaphu.hdr” file

4. Go to Write tab and check product 
output name (I add ”_unw” to wrapped 
product name, so I get a new product)

Phase Unwrapping
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Interferometric Processing

1. Finally, we can now display the 
unwrapped phase

– Select the Unw_Phase_ifg band
– Go to the Colour Manipulation tab 

and select “100%” to stretch color 
scale to full range of unwrapped 
data

– Unwrapped phase is still in radians
– Phase is reference image minus 

coregistered image. If reference 
image is earlier, then negative 
phase is land moving toward 
satellite (negative range change)

Phase Unwrapping
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Interferometric Processing

1. We can convert the unwrapped phase to 
displacements. From the top main menu 
bar, select Radar, then Interferometric, 
then Products, and then Phase to 
Displacement.

– The I/O Parameters tab should be set to 
the unwrapped product that you 
imported. 

– default for target product name is to 
add “_dsp” to the name

2. Now, we can display displacement band 
of result. Again, better to stretch colors.

– Displacements now in meters. 
– Sign was changed so positive 

displacement is “up” towards satellite

Phase to Displacement
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Interferometric Processing

1. SNAP calls geocoding with topography “Terrain 
Correction.” From the top main menu bar, select 
Radar, then Geometric, then Terrain Correction, 
and then Range-Doppler Terrain Correction.

– The I/O Parameters tab should be set to the 
displacement product that you imported (or 
one of the other ML products). 

– default for target product name is to add 
“_TC” to the name

– Under Processing Parameters tab, select the 
Source Bands and any additional Output 
Bands. You can also choose what DEM to use, 
output spacing, and map projection.

2. Now, we can display displacement_vv band of 
geocoded result. Again, better to stretch colors.

– Displacements in meters with positive values 
“up” towards satellite in Line-of-Sight direction.

– Product is now evenly spaced in latitude and 
longitude.

Geocoding results—Terrain Correction



Image Credit: NASA/JPL

InSAR Analysis for Earthquakes
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Earthquake Displacement Analysis

1. Use the line drawing tool (top bar of SNAP 
window) to draw a line across the signal.

2. Run Analysis>Profile Tool to see 
displacement along the profile

3. Remember that InSAR displacements are 
relative

– In this case, displacement far from the 
signal is about -0.1 m, so that is probably 
the “true zero” offset

– Maximum is about 0.24 m, but we need 
to subtract zero offset to get total 
displacement of about 0.35 m

Displacement Profiles
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Earthquake Displacement Analysis

4. Zoom in to the main signal.
5. Notice the sharp discontinuities in the 

displacement near the coast in my 
interferogram (yours may be different):

– Pin 1 in the figure points to the largest 
discontinuity

– Go back and look at fringes of the 
wrapped interferogram

– Wrapped interferogram has noise at 
that location but phase looks 
continuous, so this is likely a phase 
unwrapping error

– You may need to adjust filtering and 
multilooking to get better unwrapping

Unwrapping Errors
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Earthquake Displacement Analysis

1. For more analysis, you may want to 
use Matlab, QGIS, ArcGIS or other 
analysis tools. QGIS is great free and 
open source tool (https://qgis.org).

2. You can export the geocoded 
displacement map with the 
File>Export function

3. For GIS analysis, the GeoTIFF format 
usually works well

4. In QGIS, can use ”Add Raster Layer” 
to read the GeoTIFF file.

Exporting Displacement Map

https://qgis.org/
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Earthquake Displacement Analysis

1. In QGIS, can modify the color scale, 
load other information from various 
sources

2. Can also add annotation like scale 
bars, labels, and legends in QGIS 
Print Composer

3. Here, I added epicenters from two 
sources (USGS preliminary and SSN 
Mexico preliminary) and contours on 
depth of the subducting slab from 
Slab1.0 database (Hayes et al., 2012)

Comparing to Other Data
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Earthquake Displacement Analysis

1. For this earthquake, most of the 
displacement is in the IW1 subswath that 
we processed from this track

2. For more complete analysis, we should 
process at least the adjacent IW2 
subswath and then use TOPSAR Merge

3. SNAP has built-in Graphs or combinations 
of steps into a single workflow under 
Tools>Graph Builder, then Load button.

4. Running Graphs can take huge amount 
of memory (much more than running 
each step separately), but you can also 
use them to see correct order of steps 
(TOPSAR Coreg Interferogram IW All 
Swaths.xml shown here)

Merging Subswaths
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Earthquake Displacement Analysis

1. Caltech-JPL ARIA and ASF have joint 
project called Getting Ready for NISAR 
(GRFN)

2. Some sample “Beta” Sentinel-1 
interferogram products were processed 
by ARIA and stored in ASF Archive

3. In our original ASF Vertex search, there 
was a GRFN product available that is 
two slices and all three subswaths
stitched together: Granule S1-
IFG_STITCHED_TN005_20180217T00390
6-20180205T003836_s123_along-
7556-v1.2.1-standard

4. Can download Unwrapped 
Interferogram and Coherence Map

Getting Ready For NISAR
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Earthquake Displacement Analysis

5. The GRFN Sentinel-1 “Beta” 
interferogram products are in the 
InSAR Scientific Computing 
Environment (ISCE) format

6. QGIS can read the “.vrt” file to load 
the raster layer

7. Map shown here is full stitched GRFN 
unwrapped interferogram converted 
to displacement

8. Note many variations far from 
earthquake that are likely due to 
water vapor in atmosphere

Getting Ready For NISAR
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Earthquake Displacement Analysis

1. Fault slip modeling is an advanced 
geophysical topic

2. One or more interferograms can be used to 
estimate slip on fault at depth with inversion 
methods

3. Interferogram is sampled at about 500-1000 
points (top)

4. Then inversion determines slip on fault and 
estimates synthetic interferogram (middle)

5. Difference or residual shows how well slip 
model fits data (bottom)

Earthquake Modeling
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Earthquake Displacement Analysis

6. Map view of slip model on fault with 
5 by 5 km patches

7. Fault from Slab database
8. Inversion with Caltech fully Bayesian 

slip inversion AlTar (Minson et al., 
2012)

9. Used GPS, three Sentinel-1 
interferograms (A005, D143, D070) 
and one ALOS-2 interferogram

Earthquake Modeling


	SAR Interferometry for Earthquake Studies
	Learning Objectives
	Prerequisites
	SAR Interferometry Theory (Review)
	SAR Interferometry Theory
	SAR Phase – A Measure of the Range and Surface Complexity
	A Simplistic View of SAR Phases
	SAR Interferometry Applications
	SAR Interferometry Applications
	Differential Interferometry
	Differential Interferometry Sensitivities
	Phase Unwrapping
	Correlation* Theory
	InSAR Correlation Components
	Wavelength: A Measure of Surface Scale
	Coherent Change Detection
	InSAR Applications—Earthquakes, etc.
	Some Examples of Deformation
	Asal Rift Dike Injection
	2015 M7.8 Gorkha Earthquake in Nepal
	Creep on the San Andreas Fault
	Decorrelation Shows Surface Ruptures
	Correlation change
	Landslide Motion
	SAR satellites
	new SAR spacecraft
	NASA-ISRO SAR Mission (NISAR)
	Accessing, Opening, and Displaying SAR Interferometry Data
	How to Get Data for InSAR
	Southern Mexico Earthquakes 2017–2018
	Accessing Sentinel-1 Data for Interferometry
	Accessing Sentinel-1 Data for Interferometry
	Opening the Data with the Sentinel Toolbox
	Opening the Data with the Sentinel Toolbox
	Opening the Data with the Sentinel Toolbox
	InSAR Processing
	Interferometry Data Preparation
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	Interferometric Processing
	InSAR Analysis for Earthquakes
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis
	Earthquake Displacement Analysis

